Deltek

Speed. Clarity. Control.

Deltek Open Plan® 8.8

Milestone Professional Interface Add-In Module

April 22,2026



Deltek

While Deltek has attempted to verify that the information in this document is accurate and complete,
some typographical or technical errors may exist. The recipient of this document is solely responsible for
all decisions relating to or use of the information provided herein.

The information contained in this publication is effective as of the publication date below and is subject
to change without notice.

This publication contains proprietary information that is protected by copyright. All rights are reserved.
No part of this document may be reproduced or transmitted in any form or by any means, electronic or
mechanical, or translated into another language, without the prior written consent of Deltek, Inc.

This edition published April 2026.
© Deltek, Inc.

Deltek’s software is also protected by copyright law and constitutes valuable confidential and
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related
documentation, is provided for use only in accordance with the terms of the license agreement.
Unauthorized reproduction or distribution of the program or any portion thereof could result in severe
civil or criminal penalties.

All trademarks are the property of their respective owners.

Milestone Professional Interface Add-In Module ii



Deltek

Contents
OVERVIEW 1
PROCESS FOR MILESTONES INTERFACE 2
OPEN EXAMPLE PROJECT IN OPEN PLAN 3
SAMPLE PROJECT (MILESTONEO1) BARVW VIEW. 4
USING MILESTONES PROFESSIONAL SAMPLE FILE 5
LAUNCH MILESTONE INTERFACE TOOL VIA OPEN PLAN 6
MILESTONE INTERFACE DIALOG BOXES 7
MILESTONE MAPPING TOOL OVERVIEW 8
BROWSE TO SELECT MILESTONES CHART 9
GETTING READY TO START MAPPING 10
INITIAL MAPPING STEPS 1
REVIEW THE APPLIED MAPPING 12
MAP ADDITIONAL SYMBOLS 13
LAUNCH UPDATE TOOLS 14
MILESTONE UPDATE TOOI 15
UPDATED MILESTONES FILE 16
EXAMINE DETAILS OF MAPPING 17
EDIT MAPPING TO DEMONSTRATE AN ERROR REPORT 18
UPDATE TOOL INDICATES IF ERROR OCCURS 19
UPDATE GROUP OF MILESTONE FILES 20
SHOW PROGRESS UPDATES WITH MILESTONES INTERFACE RULES 21
SCHEDULE STATUS RULES (SSRIS) e rvveeeeeeesmmsssssseeesesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnns 21
WARNING — SSR RULES AND LOCAL USER FOLDER......ctuuieeeieieeeneiseeeeeeeessesssesssesssesssesssesssessssssssssssssssssssssssssssssssssssssssssnns 21
MAP TO SCHEDULE STATUS RULE WITH A STATUSED PROJECT 22
SCHEDULE STATUS RULE DEFINITION DIALOG BOX 23
DEFINE SCHEDULE STATUS RULE 1 (SSR1) 24
MAKE HORIZONTAL CONNECTOR 16 A LOW DASHED LINE 26
DEFINE SCHEDULE STATUS RULE 1 27
MAP TO SCHEDULE STATUS RULE 1 28
EXIT MAPPING TOOL AFTER MAPPING SYMBOLS 29
UPDATE WITH THE NEW MAPPING 30

Milestone Professional Interface Add-In Module iii



Deltek

UPDATE SYMBOLOGY AND MAPPING 31
MULTIPLE SYMBOLS CREATED BY SSR 32
COPY SSR1TO SSR2 33
MODIFY SSR2 TO DISPLAY FINISH DATES 34
MAP FINISH SYMBOL TO TRAIN_106A, TASK 10, SSR2 35
UPDATED WITH SSR2 36
DEFAULT OPEN PLAN SCHEDULE SYMBOLIC LOGIC 37
IMPORT SSR SET FROM ANOTHER XML FILE 38
SSR RULES AND MILESTONES TOOLBOX 39
APPENDIX A: IF YOU NEED ASSISTANCE 40
CUSTOMER SERVICES.....ucvumerercrerecrererenessnessnesssnessssessssesssnessssessssesssssssssssssessisessanessisessisessinessasesssnesssnesses 40
DELTEK SUPPORT CENTER ...oucvumerrumrrirecrirecresecrescsisesesssssessasssssessssessasesssnessssessssssssssssssssssessssessssssssessssssssssssessssssesessenessenessenecs 40
ACCESS DELTEK SUPPORT CENTER ....uucuuueumnrrimerrisecrisneriseriseessssessssessssesssssssssssssssesssnessssessinessssessasessasessssssssnssssnssssnesssnesssnesssness 41
ADDITIONAL DOCUMENTATION .....corvurmenreriemseresenesenssenssenssesssesssesssesssesssesssesssesssesssesssesssesssessmssssessmnsssssssnssssssssesssesssssssesssesssesseesens 41
Milestone Professional Interface Add-In Module iv



Deltek

Overview

The Milestones Link tool allows you to use the powerful, flexible graphics of Milestones Professional with
the strength of the Open Plan scheduling engine.

At the user's request, the dates for the linked symbols in Milestones are “moved” to the accurate status
for the dates in Open Plan.
= Enables the use of Milestones Professional as an output tool for Open Plan project schedules
=  Extremely flexible symbology
=  Single-source data
= “Executive Level” output, including extensive use of chart-color
= Symbol dates are updated via the Oracle database
= Thisis controlled at the user level

You must have an Open Plan project open to update Milestones Professional files via the oracle
database.

Note: You must have a copy of Milestones Professional on your computer for the interface to work.
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Process for Milestones Interface

You need to create the Milestones Chart before you can use the Linking tool. The Map Symbols process
must be completed one time (initial setup) and then the Update symbols process can be repeated as

many times as you desire.

Updating tells the Milestones Link tool to move this symbol to the date specified in Open Plan.
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P (E_xcel Repért Schedule
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’
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Open Example Project in Open Plan

To open a sample Open Plan project:

1. Select the Projects folder in the left pane.
2. Scroll the right pane to select the MILESTONEO1 project.
3. Right-click on the project and Select Open ... Read Only.

,@ \ - B [=1e) 0 ) s Open Plan Professional - ] x

Processes Integration

Time Now ] Properties = | Calendar » Trace Logic —
4% |\ (ﬁ’l . am = || lefee = ) g it
Auto-analyze Baselines '8 Resources + Driver Analysis
Time . Resources Risk Cost  Progress Open
- Lock Project - - Eﬁl Change Mode Codes ~ Log

Open a view. ..
My Folder MName

8 MILESTONED! - Milestones Training P\ ™ "y 41 E€TONEDT - Milestones Training Project
= MOVIE - Action Adventure | MOVIE - Action Adventure

=l Movie in Progress - Action Adventure . . .
g = Movie in Progress - Action Adventure in Progress

= SHIP - Sample Project SHIP - Sample Praject
| Projects = P )

| Open Plan Library
| Briefcaze

Users

| Startup

<no filter> | Mame | g, SYSADMIN .-.JF':-‘;
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Sample Project (MILESTONEO1) BarVW
View

1. Double-click on the Views folder.
2. Double-click on the BARVW view.

Let's assume that we want to make a Milestones chart that presents the tasks of the first critical path —
going from A-B-G-D.

\ Dv =) B - = @' o )~ Project Barchart Open Plan Professional - ] x

Integration Tools Add-Ins View

=] i - - - 4
e B — s e[St S 2 (G ) B | T A Rearek

E Template .FS Manage

Add |} - 2 = - Favorites 2 Favorites
Actvity | ¥ x 5 & - & % B o B4 Clear

Xl\f | | 2018 ™
Activity ID Activity Desc. Duration | Early Start | Early Finish I Dec Jan Feb ‘ Mar | Apr | May ‘ Jun |
10 Task A 15d 01/31/2018 |02/20/2018

Time Now -J01/31/2018 |

20 Task B 10d 02/21/2018 |03/06/2018 | |
30 TaskC 10d 03/07/2018 |03/20/2018 |

o B ——
40 Tash D 10d 04/04/2018 [04/17/2048 |

uh ' o |
50 TaskE 10d 01/31/2018 |02/13/2018 !
80 TaskF 10d 02/14/2018 |02/27/2018 |
70 Task G 204 03/07/2012 |04/03/2018 i =
20 TaskH 10d 01/31/2018 |02/13/2018 i
T ==

30 Task| 10d 02/14/2018 |02/27/2018 Lﬁ
100 Taskl 10d 02/28/2018 |03/13/2018 L—ﬁ

Access Mode: e Time Now: Auto TA: OFF | Baseline: < None > @ 10 | <no filter> | <no sort> | g, SYSADMIN . oPgz2 |
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Using Milestones Professional Sample File

Instead of creating a Milestones Schedule from scratch, a schedule has already been created — you only
need to open and make a copy for each user to work with.

To use a Milestones Professional sample file:

1. Select Start Programs » Milestones Professional 20xx.
2. At the startup choices press Cancel. Close the blank schedule that is opened.

3. Select File » Open and browse to C:\Program Files (x86)\Deltek\Open Plan Professional
8.x\Sample Tools\VBAPPS\Milestones Interface Tool and open Sample Interface Update.mig
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Launch Milestone Interface Tool via Open
Plan

To launch the Milestones tool:

1. Onthe Add-Ins tab, in the Samples menu, select Milestone Interface.

’/—\ = == 0 N5 Pijm: Barchart Open Plan Professional - [} *

Processes Integration Tools Add-Ins

Task Form [5. Options Barchart Resource Selector @ Date & Status Report [5, Schedule Comparer _» Edit Addins.dat
Renumber Activities . Reset Dialogs Resource Utilization Chart @ Predecessor & Successor Report || B Mileﬁnes Interface “ Reload Add-Ins
'..DCMA 12VBS Resource Management Wall Chart || @8- Assignment Barchart

If the Milestones Interface command is not on the Add-Ins tab, select the Edit Addins.dat command in
the Edit menu group and add this line to your Addins.dat file:

Tool19=Samples:Milestones Interface;%SYSTEMDIR%\Sample Tools\VBAPPS\Milestones
Interface Tool\MilestonesInterface.exe

Note: If Tool19 is already in use, you may need to edit this part to provide an unused tool number.
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Milestone Interface Dialog Boxes

There are two parts to the Milestone Link tool. ach button on the Milestone Linking dialog box will take
you to another tool interface. Since you have not yet created any links, you should select the Map
Symbols button.

Milestones Linking

B3 Milestones-Mapping Tool X m
Map Tasks To Sympols Milestones
Wapping | I 55A Definition
Mitestones File: { Map Symbals Update Symbols E xit
Cutent Symbol Mapped Ta
line [ Projert

[
] Achivity
[

\

S FIRST Map Symbols in our
| -] Milestones Pro File with our
OPP Project

A |
5| _SLE“J ] Mapping: [ Offset [

NOTE: To map a task-symbol in Milestones

e Topate Professional with OPP, a Project must be open.
preoarad | | . 2
j ,_ Exit
Lk Symnbel To 558 The Milestones Professional File does NOT need to
I [ e ] be open - the tool will automatically open the file for
you.

Ready
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Milestone Mapping Tool Overview

Before you map any symbols, review each of the sections of the mapping tool.

= Use the Browse button to select a Milestone file that will be mapped.

= Use the two boxes on the upper left side of the tool to navigate around the Milestones chart as
you perform the mapping effort. The top box identifies the currently selected Line and symbol in
the chart. The arrows and set key are used to move to other symbols in the chart.

= The boxes on the right show the currently applied mapping on any selected symbol. You can use
this feature to examine a chart to ensure that the mapping is as you want it.

= The bottom half of the dialog box is used to select and apply mapping to a milestones symbol.
The mapping is defined by three parts —the Open Plan Project, the Activity ID in the project,
and either the Date Field on the activity or the Schedule Status Rule (SSR) for the symbol.

3. Navigation tools
help to identify the
Milestone
Professional
Symbol’s locations
that are to be
Mapped, and to
allow movement
from one symbol to
the next

<

[ Milestones-Mapping Too

Map Tasks To Symbals

Mapping_
mMilestones File:

55K Definition

ped

uf
Ty
: Lne [

o Symbal

ot
L |
L |

:ﬂ_%ﬂ

Bl

“Mapped Ta
Project:

Activity:
[

I apping: Offzet:

=

f+ Link Symbol To Date
OPP Date Field
Date

)/

Offzet

" Link Symbol To S5R
55R

S5R1 -

Ready

Help

1. Browse to select
_~~| Milestones file to be mapped

4. Current mapping applied
to a symbol is displayed

2. Mapping has three parts

- OPP Project
- Activity ID’s list here
” . Date Type or SSR #

The selections made here
are applied to the mapping
of a symbol in MS Pro
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Browse to Select Milestones Chart

To browse and select a Milestones chart:

1. Onthe Mapping Tool, click the Browse button to hook up with the Milestones file.

2. Next, select your Sample Interface Update.milg file.

I3 Milestones-Mapping Tool x

Map Tasks To Syrfyols

1 - Select Browse

Mapping | L S5R Defintion
Miestones Fie:

Current Symbol Mapped To

& Downloads # *  Name

4
1‘-5:-‘ L —T

B Pictwees [tZ] MilestoneMappingSample_BAC.mig

Prajects: Baseline [:2] MilestoneMappingSample.mig

[ ~| Milestones Intert [Z] PATH_SHIP_SUMM.MLg
Open Plan Profe [iZ] PATH_SHIP_BAR MLg
- [E] pATH_SHIP_01.MLg
[iZ] PATH_Movie in Progyfs 03.MLg
his PC [*Z] PATH_Movie in Progffess_02.MLg
Desktop [Z] PATH_Movie in Pgflgress 01.MLg
| Documents CSPR3_106_MilgftoneMapping_Sample
& Dovnloads CSPR3_106_yffGraph60-90Template
b o P6_Import gBVs

Date modified

2 — Navigate to your desktop and select your Milestones

File

=l 4 Windows (C:)
Exit

132 KB
132K8
116 KB
120 KB
17KB
126 KB
118 KB
190 KB

 Link Symbol To S5R
SSA

SSR1 -

File name: | MilestoneMappingSample.mlg
Helgy i

7 X
Line: Project B Open
Symbol | o - « 4[| > ThisPC > Documents » Deltek > OpenPlan Professional 82 > ©| | Search Open Plan Professiona... ©
e
Organize v New folder m @

| [Milestanes 2016 Files - MLG)

Cancel

Fleady
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Getting Ready to Start Mapping

If it is not already open, the tool will launch Milestones and the selected file. Deltek recommends that
you:
= Navigate to Milestones and maximize the screen.

= Select the first symbol for which the map to Open Plan is to be created. If it not clear which
symbol is selected, you should press F9 to redraw the screen.

Return to the Milestones Mapping tool and position the tool so that the tool and the area of the
milestones screen that you will be working with are both visible.

Click the Set button (in the middle of the yellow Next Symbol navigation arrows) to “sync” the tool and
the Milestones chart. The current symbol Line and Symbol # will be identified in the Current Symbol Box.

- o0

R e X
=lrE1l

SSR Defintion

L
Ol
Ol

i

unert Symbol
ine
Task Start
Dec. Jan. Feb Mar. Apr. Way. Jun. Ul Aug. Sep
— ! Hext Symbol
Task A ] ==

Task B 30619 41119 H—r

T
1

List Actiities

1 — Maximize Milestones chart window in background, then

2 BEEE T 6 6 6 g || ]
als

setting viewing size to Fit or 75%
2 — Symbol #1 on 1™ line should be highlighted with small bo>t/ﬁ ™ _e |
(Default). If not, select the first symbol to be mapped with a
mouse

3 — Bring Mapping Tool to front-right, positioning so that both S

the tool & Milestones symbols can be seen
4 — Press the Set button under the “Next Symbol” tool to begin
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Initial Mapping Steps

Currently, the symbol is not mapped — the Mapped To boxes are all empty. You are now ready to select

the three components required for the mapping:

=  Open Plan Project
= Activity ID
= Date Type

To configure mapping:

1. Select an Open Plan project from the Projects drop-down list which shows all the Open Plan
projects to which you have access. You can type in the name (or at least the first few characters
of the project name) to make it faster to select from the list. For example, select MILESTONEO1.

2. Specify which activity is inside this project. Click on the List Activities button. This is Task A
which you can see in the drop-down list is task 10. Highlight that row.

3. Set the date type at which you want to position the symbol. The date types are selected from
the drop-down. For example, select Baseline Start.

4. Click the Map button to apply the selections.

£l 153
[Z] Fle  Conmections  Edit  Dates  Inset  Layout  Format  View  Tools  Sclection @ Help
B | G z woe | O e~
St = _ N %
Q L ‘:'e\—‘:; S e |Left v (CRet ) Map Tasks To Syrbals
Z]”| connet ao ey By T Sormmeny/vienc [ y:‘:dm Fyparines || Conseans ] Symbol ks ;'{‘.'.;’_‘ZZZZ‘"‘H Verocal s | ) i F""ﬂw'"ﬂ [ shvetmin | R
:‘\Eilmas - DocumentshD. = W T
Page of 1 I Current Symbol Mapped To = +\ gjo
Task Start 2019 ;m.;’: s =
Dec Jan Feb Mar Apr May Jun “Jul "Aug Sep ’?E‘W— tle——t
S I Next Symbol I — En
Task A 111619 4/29/19 fgﬂ_?fﬂ j EH Mepping: BSDATE  Offset: [ : —
1 _ Select Project _ (MILESTONE01) |M0H;E>5:::EBDW>>M\LESTDNESTRA\NINEPHDJ\j M $%
. . C e et 35 Tos +|e=s
- Click “List Activities | —— e HE=s
—A 605> Task F =
2 — Select Activity — (Use Task A) ;EDIT;’J e
E - 7 T + -
o - This is for Symbol 1, Line 1
3 — Select Date Type — — | e || | 2o
] - Use BASEL'NE START - P | [t e i ;:T:r:wm
H H T H H ool To SSA e sens
=71 SR Help S Meate
4 — Once complete, select “Map” F— | EET—
. S S B Fnas
. | | | | | Mapping of task to date BSDATE 5> BASELINE START is complete. L v %“"“’“‘“—
Wednesday 116/19 ‘0 100% ] Dep. Mode: OFF |Undo: MO All ::ZSN;:\‘M&
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Review the Applied Mapping

After you click the Map button, the Mapped To box is populated.

If the Mapping is not correct, you can adjust the selections and click the Map button again.

13

Connections  Edit  Detes  lnsert  Loyout  Format  Yiew  Jools  Selection (@ Help

| gommowe B co | = U
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Hide -

oot |Center | | . .
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=,
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0~ @ . U
E = Ee — i 53R Definiion
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Milstanes Fie
[ Tserstrobertedwags o e e W sl m m
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I

t
1

Lire o Foiect
MILESTONEDT
TaSK Stan m 2019 / : : kmww.
Dec Jan Feb Mar Apr. May Jun Ul Aug Sep e —
. : .
L ]

d ’TaskA—
P ”
Task A viene  ageng = //

Mapping: BSDATE Offset

Note the Mapped To box reflects mapping " b [

just applied
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and nress Mab aaain // E
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Rk i / @ Link Symbol T Date = s
Task D 1130119 52919 g / orPDetefeld g e
: : : : BSDATE »> BASELINE START - = Lock Bassine
o - = & i
Use Navigation arrows to move £ 5
s5m > | B
to next svmbol to be manned W ot e
—_— e
Hiapping o task to date BSDATE »» BASELINE START is complete v Sic Frare.
B > B ronea
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Map Additional Symbols

If the mapping is correct, you can use the Navigation arrows to move to the next symbol to be mapped.
Click the right arrow to move to Symbol 2 on line 1 which can be seen in the Current Symbol box and can
also be seen with the selection box around the selected symbol. For example, you will map this symbol
to the Baseline Finish of task 1.1.1.1. Select Baseline Finish from the date drop down and click the Map

button.

Click the down arrow to move to the finish of the next task. Select task 1.1.1.2 (Task B) from the task list.

Since you are at the finish, you do not need to change the date type — just click the Map button.

Click the left arrow to move to the start of Task B. Change the date type to Baseline Start and click the

Map button. Continue to map all eight symbols on the chart.

&)
[iZ] Ele  Connections  Edit  Dates  Insert  Layout  Formst  View  TJook  Selection (@ Help
12 oo B o= W v e
= 8 oo X o s Center V|| yin, |
=, ity o v -
g von [0 ] @7 ] o o= | B e s=cf B3 Milestones-Mapping Tool
Map Tasks To Symbols:
=r| After pressing the Right Arrow, the s | ST
isones Fil: ~EIR [T
. . [C:\Jsers\robertedwards\Documents\Dekek\Open Plan Professional J
next symbol becomes highlighted Curnt Sl || Mmoo NO[C
e [ Project: [ Py
Spmbel /QAD\MLVE‘E'TDNEm [ -
ey Jun | Jul | Aug T — +le——
ot Symbol s
' N Task &
ﬂ ﬂ M Dffset: =
Task A 11619 4129119 H -LH opeing BFDATE | Offset: [ + | —
+ | ==
Projects T
‘M\LESTUNEUT »» MILESTOMES TRAINING PHUJ\ﬂ m im
tlel o
Task B 369 41118 =1 D5 TE | G
g 205> TaskD =
i 505> TaskE
H=
. . . Jeg Al
For this symbol, the project & task selections 2 Jokd He—
100> Task ) + | ===
remain the same. Change the date selection LG
A A=A ' Link Spmbol To Date . swvepor
to Baseline Finish. S—— et 5 o v
BFDATE »» BASELINE FINISH > = LockBuseine
- Then select Map > A e &
€ Link Symbol To 53R L sena
%]
INI~tn 4lam SN A~ A TAY casill s im At soR S
B Metame
Yy W oo pes
q % rns
Map a” SymbO|S, then Se|eCt EXlt Mapping of task to date BFDATE >> BASELINE FINISH is complete. V%”“”‘”
< > Find Nd
Monday 4/29/19 @ 100% ] Dep. Mode: OFF |Undo: M0 AllLines Vl\l:l‘h\e

Note: You can map symbols in a chart from activities in different Open Plan projects. To do so, open

another project, list its activities, and map to the symbols.
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Launch Update Tools

After mapping, you can browse through the symbols using the navigation arrows, looking at the Mapped
to box to ensure that the correct mapping of symboils is in place.

When you are satisfied that the mapping is correct, click the Exit button to return to the Milestone
Linking Select Action dialog box.

Having completed the mapping, the next step is to update the symbols to position each symbol at the
date from Open Plan.

Click the Update Symbols button. There are two options on the Update Tool:

= Update a single Milestones file

= Update a group of Milestones files

Now select Update Symbols

&, Milestones Linking (+3.1.0:02")) Milestones - Update Tool
Milestones v Single Milestones File
|E:\F'mgram Files [#86\Delteks0pen Flan Pro
Map Symbals )
Projects:
v
|Feady [ A
Browse to select the
Milestones Pro file
— Opens your file
O Milestones Group File
Use update a Single Milestone file |

[v Clear Highlighted Symbals Before Update?
[+ Highlight Spmbols Changed During Update™

Update Exit Help

Note: While you do not need to save the Milestones Pro file for the tool to work, Deltek HIGHLY
recommends that you do in case of mapping errors.
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Milestone Update Tool

For this example, you will use the default setting to update a single Milestones file. Click the Browse
button on the right side and navigate to the milestones file you want to update. Click OK.

All the Open Plan projects that are mapped to this milestones chart are shown in the projects box. If you
want to skip an update from one project, they can deselect the check box.

After selecting a file, the Update button at the bottom of the form is now active. Click Update. The tool
updates the date for the symbols. If it encounters any errors, they are identified in an Excel spreadsheet.

-~ o
[Z Fle  Connections  Edit  Dates  Inset  layout  Format  View  Tools &
B gommovwr B oo (U0 = some | S
g ® X |7 o ) : cener | [
S| iy = ~ . - — Defait v []
s [F0E (D]
DUl s B Cleomeeerue | Sretrtoe [~
After Selecting Milestone file, it will open I N T
: : . N[}
and all mapped OPP Projects will be listed T e
Dec "Jan Feb Mar ‘Apr May m_u' @~ Single Milestones File Flet o
Task A 1116119 412919 N R S B s BE=5
+[ ==
) [
/ =
Task B 36119 411119 i // i o
/ =
/ F==
TaSk G 4213 S2449 / © Milestones Group File
s
User can elect not to update symbols -
T from a particular project by dese'ecting ¥ Clear Highighted Symbols Before Updale?
¥ Highlight Symbals Changed Duiing Update?
Y AN A P PO
Update | Esit Help
, [
Wednesday 5f29/19 @ / 100% L ] Dep. Mode: OFF |Undo: MO Al L\:es Visible:
Click Update

When complete, it will say “Milestones file processed.”
You can exit tool now
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Updated Milestones File

When you look at the Milestones updated chart, you should see that the dates have been moved to

baseline dates for each of the tasks.

Milestones - Ig]
File  Connmections  Edit  Dates  Insert  Layout  Format  View  Toels  Selection @ Help
e o
EI > BIU
]
(x}
e et Do Dsog 53| [ Use custom e forma
=" Font
Page 1 of 1
Dec Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
Task A 113119 2120119 {}:/,}
Task B 2121119 3/6/19 1e1)
Task G 377119 413119 b
Task D 414119 417119 Y13
Mapped symbols will be updated/moved to
_| current OPP Project Baseline Dates
If \in11 raraivia an Fveral fila Frrar chaat — raviaws
Page 1of 1

Dep. Mode: OFF |Undo: M0

-8 x

|+
Oj=
O+

|

e Fnarmes.
Y 4 Frd e

M.
Al Lines Visible:
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Examine Details of Mapping

To examine the details of the Links.
1. Make sure that you have selected the Arrow tool.
2. Double-click on the first symbol to display the Symbols Properties dialog.
3. Select the Notes tab. The first three lines of the notes contain the mapping — Open Plan Project,

Activity ID, and Date type. You can enter this data manually instead of using the Mapping Tool.

| =
File  Connections  Edit  Dates  Insert  Layour  Format  View  Tools  Selection @ Help
et | |
[ [

i
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I atinch Sumhanl Pranartice I
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Syl (1 Selected)
H o g o |1 2]

=
s
[}

Time

Background Color: [I] Connector Type: Color: [righlght Symbols with Notes

~[+k|T
Page 1 of 1 Symbel Properties T X T\ o
e o S =
.FEb Mar, Aprol Thursday 12]:[o0 %h_.
i : i Text  Size/Coloy ry Notes Hyperinks Constraints Symbollinks ValueSets Vertical Links E:
Task A 113119 22019 i = — | —
: : +| ==
- L SmEsToE! ==
Select Notes Tab =~ ssowre om0
Task B 1 e f e
i i / % ==
First 3 lines of notes contain “Mapping” to / |
:
OPP Project: L
':

-P roj ect Name Terget colors [ ] 5o o= tomosrs Sove PO
[JDisplay Motz on Schedule 5[ Copy Powerp|
. . Frame Color: [II| Spedal Effects: Cloisnay Note Shadow e
- ACtIVIty I D Shadow Color: [IT] Nene | [JConnect to Center of Note &) publish
Text Settings for This Note b sena
- Date Type @it Qomr Cugn  Fort [ <] rome i 3 e
Osod Crwic  Cunder  Coor: [ siz=:[14 W Gotopace
No other information can exist in the L
Cancel fohc D
" - " : ¥ B fnanea
< & L P
Thursday Y3118 4 00% B [Dep. Mode: OFF [Undo: ® 1 All Lines Visble

Users can manually enter/update “Mapped” Info via ‘Notes Tab’

or carract Mannina Frrare with tha OPP ‘Man Symhanl<’ Tanl
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Edit Mapping to Demonstrate an Error
Report

To modify the data to illustrate how the tool would handle an error in the mapping:

1. Change the Activity ID to be 11. Perhaps there used to a task 11 that was deleted from the
project.

2. Click OK.

[iZ] File  Connections  Edit  Dates  Insert  Layout  Format  View  Tools

moove | L

rent Object:
Symbol (1 Selected)

[3

Center | J

- = Defadt - D;
o= App
| — e

L]0 Tt lace
o [ Sommaniar [ Tiotes [ Fyperinks [ Conmwants [ Symol G [ Veloesers [ Vereal Tk |

- Copy [ Lt laceme:
NEAY
P 10f1 =
age 1 of Symbol Properties 7 X% =

More About the Symbol Menu

y
. Date +F|
Task m Finish [ gy Y7 S +
Dec Jan ‘Feb Mar_ Apr 7] Trursday 2l E
i Text  Size/Color/Summary Notes  Hyperinks Constraints SymbelLinks ValueSets Vertical Links ol
Task A 1131119 212019 =t Symbol Notes %
i MILESTONEO1 T
B 11 T
H ’ BSDATE =
! / +
Task B 221119 3/6/19 i) |
j £y
P =
. gl
Change second line to 11 L =
(An ID that does not exist in our Project) t— . e L - P ——— j
[ Show Note Numbers Save PDF
Task D aars a7 o e dGED [ ——e W o T 5 co e
Frame Color: [NNN] Specil Effects: Iiplay Note Shadow I Lock Bassing
Shadaw Color: [ None ~| [comect to center ofNote &) puvien
Text Settings for This Note £8 sena
@Left OCenter Opight ot A | Frame Type: B3 mewie
[leod [limic [lunder oo [l See: [14 v M Goto page
% Fna
Select OK B
a e e S Fdimep.
— el - Y B Find e
< ..
Autosaved wo% W Dep. Mode: OFF |Undo: M1 Al Lines Visble
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Update Tool Indicates if Error Occurs

Return to the Milestone Link Tool —if it is not still in the Update Symbols tool, select that button.

Select the Milestones chart and click Update. An error displays.

Go to OPP and Rerun ‘Milestones Interface’ /
‘Undate Svmbols’ tool

® H s
HOME | INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA  REVEW  VIEW  DEVELOPER

B X Cut

1. Rob ecweares + [

S ca o E 7 [ Bx [] Zmer by i
Paste P BIuU- . ditio i e Format ' Sort & Find &
S S ot u- s ™ o el frd

Clipboard [ Font [ Numb [ Editing ~
AL - Jr v
A 5 c D 3 F G H B
1
2
E Wilestones File OPP Project _Activity Date Type Offset Symbol Line_Symbol Number Error Message
4 [ MilestoneMappingSample.mlg_ MILESTONEOL 11 BSDATE 0] 4 2 Activity doesn't exist in the project. C:\Users\ro| = | Single M| i
5 merlDelEk
6
Milestones - Update Tool x
7
s

ted during the update.
readsheet that was created.

9
L e

;

.
s
.

7 —— ]|
18
:
20

Milestones fi d

* Lstoat [ ® —| Click OK to view Report

Excel Chart opens |

Book? - beeel ?®m - 0 %

HOME  INSERT  PAGELAYOUT ~ FORMULAS ~ DATA  REVIEW  VIEW  DEVELOPER !RabEdwavds'ﬂ

e X Cut véY H

D e cony -
paste o Sort & Find &
Filter - Select ~

- B WapTet

Calibri MLME. Y
B I U-~- - OrA-

+* Format Painter

Clipboard 5 Font 3 Alignment 5 Number 3 Styles cels Editing -

He M Jie | Activity doesn't exist in the project. -

) Vi e Error Message File Path
M [Milestonemap, ivity doesn't exist in the project. |C:\Usersl Open Plan Professi

i Mapped Symbol location Error type

i with error

Sheetl ® < v

To find a symbol on a large file — use Edit/Find...

“Symbol Notes Only”
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Update Group of Milestone Files

To update a group of Milestone files:

1. Set up csv file with list of Milestones Be Sure that
extensions are

N ALL CAPS

C:\Usersiyourname'Documents\Deltek\Open Plan Professional 8.2\MilestoneMappingSample.mlg
C:\Users\yourname‘\Documents\Deltek\Open Plan Professional 8.2\MilestoneMappingSampleB2.mlg

j Untitled - Notepad
File Edit Format View Help

2, Select the Milestones Group radio button and then Select the file from
the ellipsis button, and then the Update button.

Milestones - Update Tool

& [ Single Mikestanes Fie

[C-*Program Fils (+BBND ekek pen Plan Fri .
Projects:

- Milestones Group File

I L

[¥ Clear Highlighted Symbols Before Lipdate
¥ Fighiighi Symbcis Changed During Lipdate 4

Update Exit Help
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Show Progress Updates with Milestones
Interface Rules

The Map to Date functionality allows you to get any symbol to the correct date, but an enhancement to
that is a way to have the symbology adjust to changes as progress is entered into a project. The
definition of Schedule Status Rules (SSR) allows you to accommodate changes in symbols with having
to create a mapping for all possible combinations.

SSRs, similar to Bar types in Open Plan which are a hierarchy of symbols, allow the definition of many
rules that are only executed when the dates for the symbols are valid. Each SSR can draw any of the
symbols on the Milestones toolbox.

After the SSRs are defined, each set is associated with a Milestones chart. The definitions are stored in
an . XML files in the user folders.

Schedule Status Rules (SSR’s)

= Defining Schedule Status Rules (SSR's) allows you to show changing symbols from a “single
mapping” to a "multiple mapping” ... mapping to multiple Date Types.

= Definitions are similar to Bar Types in Open Plan
= Hierarchy of symbology that is shown when dates are “valid”
= Canuse all symbology in the Milestones Chart toolbox
= SSR’s are stored for each Milestones chart
= Reused for subsequent updates
= Can be shared with other Milestones Professional charts
Warning — SSR Rules and Local User Folder

= Schedule Status Rules are stored in the local user's “My Documents\Deltek\Open Plan
Professional 8.6" folder. (File name SSR.xml)

= When working in Citrix environments, care may need to be taken to make sure these are
preserved and available on various servers.
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Map to Schedule Status Rule with a
Statused Project

To schedule status rule with a statused project:

1. Return to the Mapping Tool dialog and select project MILESTONO2 which is a progressed
version of MILESTONO!1.

2. For the symbol 10on Line 1, select the Link task to SSR radio button and then SSR1 from the
dropdown. Click Map. An error message displays that the SSR is not yet defined.

[ B2l vaie
File = Conmections  Edit  Dates  Inset  Llsyout  Format  View  Jools  Selection Help
o - @ - ] ~m Cl U
D REWE B2 & =
e Nizard  Open Close. = aue As ave As - =7 :
= e i | T —— I
. « | | B Milestones-Mapping Tool X
Re-Map Task A to Project MILESTONO02, Task 10 [ rr———
ap Tesks To Symbols
(Same Project with performance - to see changes) o Hepeino ST ) e [N
estones Fik: 2
[C:\sershroberte dvwards\D ocuments\D ehek\Open Flan Professional . | O]
Current Symbol Mapped To tloe—2=
Task Start Finish 2019 e i Project + | ot
Dec Jan Feb Mar Apr Ma?\{ Jul Al Se| Symbel [ ch\hﬁsy‘-mwsm I -——t
| o
H Hext Symbol |
. Task &
1131119 220119 \ 2 + | —
Task A @:ﬁ \ Al _SLE“J 2| | Mapping [ESDATE  Ofket o +| ==
e
Profcts: + |
‘M\LESTDNEDZ» MILESTONES TRAINING PRDJ\j List Activities T el o
Task B 2121119 306/19 oty ol
ERE HESS
4055 Task D + | /=
50355 Task E
R0 TokE tle==
05> Task G
) =ty aniiw:iw : .:°
305> Task| e
Select the Link Task to SSR and EHALA A
b !
SSR1 from the drop down e
=y € Link Symbel To Date e
. OPP Date Field
Select: Map S~ SrPDskere Susanas
-y ’—Ll '_ Pubiish
\\ e 58 seca
N ¢ Lk 5 S v
o Help P oo page
5SA1 -
B o
8 Fnamep
< Rleady _ 62 im bisx\
Thursday 18119 4 00% W Dep. Mode: OFF |Undo: M0 AllLines Visble

ERROR: Must Define SSR’s prior to Mapping

Milestone Professional Interface Add-In Module

22



Deltek

Schedule Status Rule Definition Dialog Box

There are up to 20 SSR definitions that can be associated with each Milestones chart.

Each line of the SSR allows you to show two symbols and a connector. The symbols and the connectors
are all from the Milestones toolbox. Each line is only drawn if both dates are valid. There can be up to 8
lines defined for each SSR.

Each SSR can have 8 lines of definitions which are drawn sequentially when
both Start/Finish dates exist
(I F - Base Start/Finish Base Start different than Actiial Start Fte)

B} Milestones-Mapping Tool x
Map Tasks To Symbols
Mapping I 53R Definition

Select 55R Copy 53R Copy 55R:Source XML Fils
[ssR1 ~| From [ssp1 »] To [ssmi +] Copy [ J Select
Set SSR Definition

OPP From D ate Fields Symbol Cannectar Index Symbol OPP To Date Fields \
ol = [ =]
S = [ ]
] =] [ =]
Al = [ 5]
ol = [ =]
LIl =] [ 5]
] =] [ =]
ol = [ & |

Up to 20 SSR’s can be defined
for each chart
(only 3 are really needed)

= Symbols and connectors are defined by the
| Milestones Toolbox, Symbol/Connector
-
-

positions in your particular Milestones
Professional file

ol el 1] 1]

|l

Fleady
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Define Schedule Status Rule 1 (SSR1)

To define the Schedule Status Rule 1:

1. Click the Set SSR Definition box next to the first line. Previously, you were drawing the Open
“doghouse” at the Baseline Start for this task, so you will start with that in the Open Plan From
Date.

2. Inthe Symbol drop-down, select symbol 1in the toolbox. You do not need (or want) a second
date and symbol on this line.

3. Click the check box to turn on line 2. In the From Date select the Actual Start date.

[ Milestones-Mapping Teol X
Map Tasks To Symbols by
Mapping Il SSR Definition
Select 55R Copy 55R Copy 55R:Source XML File
[ssAT -] | | From [sspr ] Te [ssm1 -] Copy [ | sekat
Set 53R Definition
OPP From Date Fields Symbal | Connector Index Symbol | OPP Ta Date Fields
b [BSDATE »> BASELINE START | P Blark. ] T=L L ]
e [ASDATE 5> ACTUAL START ~| PE onnector 16 v |
= el - Select Symbol for
=Bl o | | —— Baseline Start,
= cliimEll SImEL <]
=i i e — e -]
O o i ) — e <]
= o | 1 1 = =]
Chark aarh Data Fiald tA “tiirn An” a BIERERS
T T s . T =l
|l =l =1 =]
- =l = | = Save Aue |
|l =l =l =l
Help
Fieady

4. Onthe second line, you need to show the Actual Date as slipped from the baseline. You have
already selected the Actual Start date from the drop-down and now you select the Solid
Diamond shape. It would be nice to select a dashed line (at bottom of symbols) to show the slip,
but there is no Horizontal Connector like that defined. Go into Milestones and redefine the Bar
16 to be as desired.
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£ witest ) - o x
= Selecting Connectors & Symbols o
| ne .
E Requires a standard Toolbox
E 158 @ /P P e T %
= Files and Templates: Open and Save Options Mapging T SR Definition
Copy c I S+ T
Page 10f1 SSR1 - [me ssR1 - Tofssmn -] cow | L | s 1 = E:(')
I [eussn DDPF‘me Spmbol e OPF To Date Fields : :j'
e s N — I El 2 3=
Task A — | [aSDATE > ACTUAL START "_Ll [Comestor1s | [ = 3 |z __:
= T =l | =l GE=S
Pl | = | 3 4 |Fe—=
Task B e ||[|7 ] I gl T = el s
oo | = | 20 5 |z
DR I =l T =l 6 *
Task G smno |||7 | I = | = :
Task D If you don’t have a good connector in the — g |27
toolbox (such as we don'’t in our example), then 8 é‘““
change the Toolbox in Milestones Pro to reflect w || 10 i
B s
a correct connector type. 11 |
?W’m’i ~_ 1 cece D0V =l == (= = A= Al = =cec i 12 7%

13
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Make Horizontal Connector 16 a Low
Dashed Line

To make the horizontal connector a low dashed line:
1. Double-click on Connector 16 to display the Connection Options dialog box.

2. Change it to Connector Type 9 with a dashed Line Pattern.

EMiIestones Professional - [TZ364A Milestone Link Sample.ML9]

T |
Sample Connector Fill Fill Calor
D |_—_| I_j I- Custom j 2005
--------------- Line Patkern Line Color e o :_‘LV_E i {l
O | [wmce o] | 0
Fill color Msed after After Status Fill Colar
"Status Wate" when Fil -
to Statuf Date option is I thite: j
ackive: ! ! '
. White hi : : H
T ot | | i i 1. Double-click to select
afcer stfus Targac colors [ whie v i | Horizontal Connector #16

Arrowhedl] Size {Arrow Conneckors Onl
’7 Small £+ mMormal £~ Large ‘ i

i Shagw Settings (Bar Connectors Onl

Shiow Shiadays Stlhdow Size: (% Small
adow Color; £ Wedium
Silver - £ lame L

2. Change #16 Connector type to 9 and
Line pattern to dashed
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Define Schedule Status Rule 1

To define Schedule Status Rule 1:

1. On Mapping tool, select Connector 16 to go between the two symbols. Select a hollow
“Doghouse” for the Baseline symbol and choose the Baseline Start date from the drop-down.

2. Eachline of an SSR definition is only drawn if both dates on the line are valid. Empty dates such
as the one on the first line are considered valid, so the line will be drawn if the Open Plan From
date is valid. Therefore, the first line of this SSR will be drawn if there is a Baseline Start Date for
the mapped activity.

3. The second line will only be drawn if there is both a Baseline Start and Actual Start dates.

B Milestones-Mapping Tool X

tap Tasks To Symbals

Mapping T

Select 55R Copyw 55R Copy S5R:Source =ML File

SSR1 - From: [ssr1 =] T [ssp1 =] Copy |
Set S5R Definition
OPP From D ate Fields Symbol Connector Index Symbol OFF To Date Fields
v |BSDATE »> BASELINE START =l 4 - Blank - | |
I [BSDATE »» BASELINE START | 4 - Connector 16 v & -| | | |ASDATE >» ACTUAL START |
I . . . ~
Lines are drawn only if both From & To Dates exist
r . R A R -
- Line 1 (Symbols/Connectors) will be drawn if the Baseline
r . hd
Start exists =l
r I . . . . S
- Line 2 will be drawn only if the Baseline and Actual Start
r Natac aviet far tha tack =
ol =] - < | [ =]
Set Progress
OPF From D ate Figlds Connector Index OFF To Date Fields
ol =1l =l =]
rol =l =l =
= = =Ml -l
i i Save Rule
| =10 ] Time to Save the rule — soeie |
-
Help

Ready

Milestone Professional Interface Add-In Module 27



Deltek

Map to Schedule Status Rule 1

To map to Schedule Status Rule 1:

1. After defining the SSR, return to the Mapping tab. When the Save dialog displays, click Save the
SSR definition.

2. Map the first symbol to MILESTONEO?2, Activity 10 and select SSR1. You can see the mapping in
the gray box in the upper right area.

| 8.2 ¢ g - o x

File  Connections  Edit  Dates  Inset  Layout  Format  View  Jools  Sclection (@ Help

@y ~ o i

|2 =) ) L)

(=] Proct oo P

5, Import Options =~
= ‘ —_ 15 Milestones-Mapping Tool X
(<] Y] D& =T (e (S ~ @y
(] SE = @ D [P L Map Tasks ToSymbols

| o0 50 e el res i 4

l

Files and Templates: Open and Save Options Export Options Master/Update Manning’ - 55A Definiion

:;“\Eiwnes i W \Deltek\Open J 8 %‘é
Page 1 of 1 Curent Symbol— g~ Mapped To ™ —\
2019 e m zﬁcs‘mrugnz L ] %%
Task Start rbol 2] o
; New Symﬂbnl | “T:skA [ ] %
| = ="
Task A 13119 2120119 // el et — i A=
+ | ==
b Y. Piojects: .llllllllllll. g
" 4 [MILESTONED2 >> MILESTONES TRAINING PROJI | _ List Aciiviies R —y
) L e
Return to Mapping tool i // ==
. =
Map MS Pro Symbol 1 of Line 1 L" He=
e 1=
Project: MILESTONEO2 HEY Lk Syl To v —
. . I Dats Offset | oo
Activity: 10, Task A = | N
- - - _-_-_— . @ Link Symbol To SSR
SSR

e

Help
>

-’— Mapping of task 1 on ine T to activity 10 5> Task & and SSAT is complete.

Select the drop-down and
s mmn ChOOSE the SSR1 (even _ ey P
though it shows, you must

AAlAaAt  A~ALR)
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Exit Mapping Tool After Mapping Symbols

Continue mapping the beginning symbol of each task.

| =] Milestones P C a estone - [m] x|
[ Fle = Connections  Edit  Dates  Inset  Layout  Format  View  Tools  Selection (@ Help -8 x
O v m@®
(] \
w (3 R
a8 New  Wzad  Open
L] £ Milestones-Mapping Tool X
%) ‘Muﬂmﬁ_MwmumszpingSzmpi&Mu
| ot ~Map Tasks To
(=7 Files and Templates: Open and Save Options Mapping S5R Definition
Hilestones File: ‘ T
= \Usels\mhevledwar@nﬂmﬁlsﬂeW\st\iP“e:ﬂ)ni ._J : D O
Page 1of 1 Current Symbol Mapped .
e T Proisct +e
Task Finish 2019 Smbal MILESTONED2 1 + |
Dec Jan 'Feb Mar Apr May Jun Jul Aug vty . e —
: ~Nest [a ] + L
i 4| ITaskD . oy
Task A 113119 212019 40 5] M g B ot W | —
¥ . =
Projscts FEEEEEEEEENEENR T2
[MILESTONEDZ > MILESTONES TRAINING PROJIv| _ ListActivities | | -
055 Task & +
Task B 212119 31619 2055 Task B S
3055 Task C *
50> Task £
i BO3> Task F i
00 Task G +
80> Task H
T
Task| When all tasks are mapped oI =
. [ — F
Select Map and then Exit
= sovepor
Task'o T =TT T T Mop BT} Copy Poner?
"B Lock Baseine
| &) pusin
@ Link Symbol Ta 55R L8 sena
SR Help By metarie
1% Fna
.
B Fnames.
= Y fna ven
< > 2 -
Thursday | wiys 4 w% W Dep. Mode: OFF [Undo: M0 AllLines Visible
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Update with the New Mapping

After updating the Milestones chart, you can see the result of the SSR: You can see two symbols now.

estones Professional - [MilestonehappingSample.mig - o x

File  Connections Edit  Dates Insert Layout Format -8 x
== U
= Link
—
~ V! Microsoft Project
8] bl By~ -
Flles and Templates: Open and Save Options Master/Update More About the File Menu
SR T
Page 1 of 1 H][@)
tle—2s
Task Start 2019 + | o
Dec Jan Feb Mar Apr May Jun ~Jul Aug Sep Oct Nov Dec + "'4‘"
H h Milestones - Update Tool +
H + [ =
Task A 113119 22019 i = & [SingeMissionesFie | |
/ C:\Usershrobertedwards'D ocuments\Deltek. _| +| ==
Projscts: 4|
Rl TN
¥
Task B 2/21] 316119 sty [
i +[=
¥
. +
3. Note the revised symbology =
oy
- Miestones Groug Fi L|
[=]] L Sove por
Task D 414119 414119 13 BT Copy Powerp
. Lock Baseine
« »” [ Updae | B Help &) pusien
2. Select “Update | || &
Milestones file processad. % Send
E vetorie
W Gotopage
) o
Sic Fresres.
18 Foavew
I e age

v
pre. age
< p T

Thursday \ 1/31/19 1}\ w00% W Dep. Mode: OFF [Undo: MO All Lines Visble
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Update Symbology and Mapping

Double-click on a symbol in Milestones to view the mapping that is created by the tool. The format tells
you which SSR is used, which line of the SSR, and which of the two symbols on that line are represented

by the symbol.

R
lof1 Symbel Properties H x ajo
Date —
Task Start Finish MpPDRAYY) Day
Dec Jan Feb Mar Ap| I3 Thursday 12]:[00 —_——
Text  Size/Color/Summery Motes Hyperinks Constraints Symbol Links ValueSets Vertical Links —
Task A 113119 2120119 *= Symb —
: —
| o rmcsrores:
S01 ._Ni
. . I
Double-click on the filled )
===
—| Diamond and look at Notes Tab ==
—
Task G 317119 41319 b/ =
1
Background Coor: [I] ComectorType:  Color: [ Hichloht Symbols vith otes T L|
[Jshow Note Numbers
Target coor: [ [ | srepoe
“ ” o [ Display Note on Schedule o 5
Task| “S01” stands for: i = p— i =
| ' 4 Shadow Color: [_] (CReset ) none | [connect to Center of Note B
Rule: SSRO1 e settos o Th e =
. @Left Qcenter Oright  Font: |Aial ¥ Frame Type: T
Line 1 Dledd Dlsie  Cloner  Coor: [l Sie: [18 E——
| i 4 Fod
oot 4 _ = .
I Find Next
" " H epage
y e
13118 4 wo0% W Dep. Mode: OFF [Undo: M1 Al Lines Visble
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Multiple Symbols Created by SSR

If you drag the symbols apart, you can see that multiple symbols are actually painted over one another.

You can delete the extra symbols — just make sure you keep the one with the SO1 mapping. The system
will recreate the other symbols after updating again.

Set SSR Defirition
OPP From D ate Fields Symbal Cannector Index Symbal OPP To Date Fields

o |BSDATE »» BASELINE START

+F Blank - = [
P Connectar 16 @ ~| | | [ASDATE »» ACTUAL START

5
5

v |BSDATE »» BASELINE START

Task A 112119 2120119

Task B 2/21/19 36/

If we drag them apart, we will see that the
single symbol that we mapped has grown to

TaSk ( be four symbols

Look at mapping notes for each Symbol
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Copy SSR1to SSR2

One way to make an SSR definition for the Finish date is to copy SSR1 into SSR2 and then make

changes.

[ Milestones-Mapping Tool

~Map Tasks To Symbol
e T SSR Definition
~ Select SR Copy 55R Copy S5R:5ource XML File
Fom [5sR1 +] To Copy 1| [ Lo | sk
~ et 53R Dafiniion —
~OPP From Date Fields ~Symbol— - Connector Index ~Symbol— ~OPP To Date Fields
¥ | [RSDATE >> BASELINE START -l Iﬂj |Blank | I J [ =l
~ [BSDATE > BASELINE START | Iﬁj [Connectar 16 ~] I.j [£SDATE 5> ACTUAL START |
2 el = || =
2 S| || = ||| B
= =T aliimEiil =]
= eliimEliN aliimE(il =]
2 S| || = || =
ool el = || =
~Set Progre
0P From Dats Fields Cannectar Indsx OFF To Dale Fields

|l =l =l =

|l =l =l =

a =) & | ] = N =
|l =l =l =

Hep |

Feady
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Modify SSR2 to Display Finish Dates

Make all the changes to show Finish dates instead of Start dates

5. Milestones-Mapping Tool

~Map Tasks To Symbol
Mapping il SSR Definition
- Select 3SR Copy S5R Copy S5R:Source XML File s
fesr2 ] {F [smi =] o [ssAl & com | {l |
- St 5SR Definiion
~ OPF From Date Fields - Symbol—| - Cornector Index ~Symbol— - OPP To Date Fields
| [BFDATE »> BASELINE FINISH = Iﬁj [Btank =] I_L,
¥ | [BFDATE »» BASELINE FINISH -l Iﬂj |Connector 16~ | l,_L, JAL FINISH
o =[] =1 |1 =
ool e ) 1 = M s =
ol e ) 1 e M e =
E ] =] =1 |1 -
ool e ) 1 = 1 e =
oI =[] =1 |1 =
- Set Prog
~ OPF From Date Fields Connector Index OFP To Date Fields
ol =yl ET | =l
ol = =]l =l
-l = | = I = SaveFiule |
ol = = ]|l =l
Hep |
Ready
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Map Finish Symbol to Train_106a, Task 10,

SSR2

On the Mapping tab, map the second symbol to MILESONTEOQZ2, Activity 10, and SSR2.

nal - [MilestoneMapp

[Z] File  Connmections  Edit  Dates  Inset  layout  Format  View  Tools  Selection @ Help - | x|

e s Above v tide v
5] Center  ~ Center  ~
=] = sckground: | Default  ~ sckground |Default v
= Dae = 2 1o 2 symbsais of the same g 1
[x] e [ 1% [ ]S #wyreea [ o — (Cammm | makeshe sesing change in the Toolbox
e |12 v |- (00 v — (< Q o [ combine text fines: ot Flacement | E3 Milestones-Mapping Tool %
ot en Cony SR oo [\ Summanihire [ Notes [ Roperines ] Corsusine [ Sombol ks T W8uetes [T 1 12 To cornoc T
] ) +
Mapping | S5 Defiriion
Page 1 of 1 Milestones File:
0] JE-\Wsershrobertedwards\Documents*\Dehek Open Flan Frofessional i3
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Updated with SSR2

After updating, you should now be able to see the multiple symbols for both start and finish.
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Default Open Plan Schedule Symbolic
Logic

The SSR that you defined do not cover all conditions that might be encountered. For example, what
symbology do you want to show if the Task actually starts on the Baseline date?

The chart shows the Open Plan Standard Doghouse and Diamonds symbology.

Not all Milestones charts need to use this same symbology. That would be contrary to the richness of
the graphics in Milestones. Even using other symbology, you may elect to use a version of the SSR.

Deltek recommends creating some standards. These will rely on the Toolbox and positions within that of
symbols and connectors.

Here is an example of doghouse and diamonds:

Original Schedule
4} ﬁ Activity baselined with 10 day
BaselineStart/Finish — i duration
Early Start”:lnlsh ! Re_me_:lnmg Duration =‘_II) days ] |
TS Actual Start early causes Early
Actual Start Early ' ¢ §Tlme hlow ﬁ Start/Finish to pull forward.
Actual Start 3 : (Early Finish is not displayed
Early Start/Finish | Remaining Duration =10 days \ unless Early Dates are toggled
5 on in bar Attributes.)
Actual Start Late ‘Time Now
Actual Star/Est Finish {T}O Actial Start late:pushes out:a
Early Start/Finish - i el <110 g | Late Finish Diamond.
Actual Start Late with Expected Finish on Schedule Late Finish Diamond override
iTime Now 5 using the Expected Finish date
Actual Start field. (Changes duration to 8
Early Start/Finish A A | days.)
Unstatused Schedule -Time Now
m Time now pushes out the Early
Est Start/Finish _ Start and Early Finish of an
Early Start/Finish | Remaining Duration =10 days | unstatused activity.

Starton Time Tme; Now Target Start after Time Now
Target Start ﬁ has no effect on Early Dates.

Early Start/Finish
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Import SSR Set from another XML File

After you develop standards, you can copy the SSR definition from one user or chart to another. Each
user's SSR.xml file can contain rules for use with multiple Milestones Pro files
To import an SSR set from another XML file:

1. Click the Browse button to select another SSR.xml file to load.

2. Click the Select button to see the rule sets saved in the xml file. They are listed by the Milestone
Pro files with which they are associated.
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—bap Tagks To Symbol
tapping T SSR Definition
~Select 55R Copy 55R Copy 55R:Source ML File
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r = . ~ -
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SSR Rules and Milestones Toolbox

SSR rules use the symbol & connector positions in the Milestones Toolbox. Common toolboxes for
multiple files is highly recommended.

= The Toolbox can be copied from a template. Right-click on the Toolbox header and select
Copy Toolbox. Right-click on the toolbox in the other Milestones chart and select Paste
Toolbox.

= You should adjust for any specific program requirements.

If you have an existing Milestones chart, it may be easier to adapt the SSR symbols/connectors than
modifying the Milestones chart/toolbox.
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Appendix A: If You Need Assistance

If you need assistance installing, implementing, or using Open Plan, Deltek makes a wealth of information
and expertise readily available to you.

Customer Services

Deltek has always maintained close relationships with client firms, helping with their problems, listening
to their needs, and getting to know their individual business environments. A full range of customer
services has grown out of this close contact, including the following:

= Extensive self-support options through the Deltek Support Center
=  Phone and email support from Deltek Support Services analysts

= Technical services

= Consulting services

= Custom programming

= Classroom, on-site, and Web-based training

Attention: Find out more about these and other services from the Deltek Support Center.

Deltek Support Center

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing
Support Plan (OSP).

The following are some of the many options that the Deltek Support Center provides:

= Search for product documentation, such as release notes, install guides, technical information,
online help topics, and white papers

= Ask questions, exchange ideas, and share knowledge with other Deltek customers through the
Deltek Support Center Community

= Access Cloud-specific documents and forums

= Download the latest versions of your Deltek products

= Search Deltek's knowledge base

= Submit a support case and check on its progress

= Transfer requested files to a Deltek Support Services analyst

= Subscribe to Deltek communications about your products and services

= Receive alerts of new Deltek releases and hot fixes
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= Initiate a Chat to submit a question to a Deltek Support Services analyst online

Attention: For more information regarding Deltek Support Center, refer to the online help available
from the Web site.

Access Deltek Support Center

To access the Deltek Support Center:

1. Go to https://deltek.custhelp.com.

2. Enter your Deltek Support Center Username and Password.

3. Click Login.

Note: If you forget your username or password, you can click the Need Help? button on the login
screen for help.

Additional Documentation

The following table lists the Deltek documentation available for this release. Except where noted, all the
user guides and quick reference guides listed in this table are available for download from the Deltek
Support Center.

Deltek Open Plan Batch Processor Guide This document contains information about
running the Open Plan multi-instance batch
processor.

Deltek Open Plan Data Tool This document provides help for all areas of the

Open Plan Data Tool application.

Deltek Open Plan Developer's Guide This document is meant to serve as a reference
manual for more technical topics in Open Plan.

Deltek Open Plan Guided Tour This document introduces you to the basic Open
Plan operations using sample project data that
comes with your installation.

Deltek Open Plan Installation Guide This document is meant to serve as a guideline
for hardware and software requirements and
provide your firm's IT department with
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Document Name

Deltek Open Plan Release Notes

Deltek Open Plan Technical Overview and System
Requirements

information about the technical deployment
architecture.

This document contains a summary of the pre-
installation information, rew features and
enhancements, database changes, and software
issues resolved.

This document is meant to serve as a guideline
for hardware and software requirements and
provide your firm's IT department with
information about the technical deployment
architecture.
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